Microsoft EXCEL 2013 - Slicers

Excel 2013’s great new Slicer feature in a formatted table is great. It gives you the ability to filter quickly without
using the down arrows and it displays all that you've filtered.

You must change your table to a formatted table for the Slicer to activate. We'll walk you through below.

The example below is a simple table that hasn’t been formatted yet.

D

- | Amount| ™ | Object Class | =

A B C

1

2

3

4

5

& |Date - | Branch

7 10/1/2009 Army $22.00
8 | 10/2/2009 Navy $24.00
9 | 10/3/2009 Air Force 344,00
10 | 10/4/2009 Marines 566.00
11| 10/5/2009 Reserves 568.00
12 | 10/6/2009 Army Guard 577.00
13| 10/7/2009 Army $93.07
14| 10/8/2009 Navy $105.32
15| 10/9/2009 Air Force 5117.58
16 | 10/10/2009 Marines $129.84

21
22
25
26
31
33
21
22
25
26

Click anywhere within the table to format. Click the Home Tab and click the Format as Table down
arrow and make a selection.
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FILE HOME | INSERT
s X Cuf

Ez c
Paste
. ¥ Forml Painter

Clipboard F]

10/1/2008 [army

10/2/2009 Navy
10/3/2009 Air Force

10 | 10/4/2009 Marines

11 10/5/2009 Reserves
12 10/6/2009 Army Guard
13| 10/7/2009 Army

14| 10/8/2009 Navy

15| 10/9/2009 Air Force

16 | 10/10/2009 Marines

17 | 10/11/2009 Reserves
18 | 10/12/2009 Army Guard
19 | 10/13/2009 Army

20 | 10/14/2009 Nawy

21 10/15/2009 Air Force
22 | 10/16/2003 Marines

23 | 10/17/2009 Reserves
24 | 10/18/2009 Army Guard
25| 10/19/2009 Army

26 | 10/20/2009 Navy

27 | 10/21/2009 Air Force
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$22.00
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$44.00
$66.00
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$129.84
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$252.41
$264.67

Date ~|Branch |~ |Amount|~|Object Class|~

21
22

DATA

EXCEL_2013_Samples Slicers xlsx - Excel

REVIEW WVIEW DEVELOPER
- B¢ - = Normal Bad Good Neutral Cal
o E° Wrap Taxt Date & ]
Formatting - Table =
Alignment M Number ]

Jr | 10/1/2009

F G

H 1 J K L

@ New Table Style..
i3 NewPivotTable Style...

Page 1 of 8



Microsoft EXCEL 2013 - Slicers

Click OK when this box appears. Now your table is formatted and we can proceed to use the Slicer.

3 I N N _
5 .i[}ate r: Branch mAmount: Dbjectclassrj
7 | 10/1/2009|Army $22.00 21; |
8 | 10/2/2009 Navy $24.00 221 !
3 | 10/3/2009 Air Force $44.00 251 |
01 10/4/2009 Marines $66.00 26!
_1! 10/5/2009 Reserves $63.00 31 |
2| 10/6/2009 Army Guard  $77.00 33)
3| 10/7/2009 Army $93.07 21!
_4§ 10/8/2009 Navy $105.32 22!
51 10/9/2009 Air Force $117.58 25!
& 110/10/2009 Marines $129.84 26
7 ilﬂfllfzﬂﬂﬁ Reserves 5142.10 31;

| Format As Table

Where is the data for your table?

=

@ My table has headers

[ ok

| | canca |

A new Design tab appeared allowing you to activate the Slicer.
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Note: If you ever want to get rid of a Formatted Table. Click “Design” tab, then “Convert to Range”
ICON, and finally answer “Yes” when dialog box appears. See Result below.

H © - s
FILE HOME INSERT PAGE LAYOUT FORMULAS
Table Mame: Summarize with PivotTable D
i;l'"able_l . | H*H Remove Duplicates ol >
*ﬂ' Resize Tahle % Convert to Range Shicer
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Properties *
-

Export Refresh

DATA REVIEW
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VIEW
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[] Total Row

[#] Banded Rows [ | Banded Columns

10/1/2009

H

DEVELOPER

TABLE TOOLS
DESIGN

[ First Cofhnn
E'LELastCrJI n

Table Style Options

Al | B C D
1]
2 |
3 |
4|
5 |
(P pate  RdBranch B Amount B4 object class |3
7 | 10/1/2003|Army 522.00 21
8 | 10/2/2009 Navy 524,00 22
9 | 10/3/2009 Air Force 44,00 25
10 | 10/4/2009 Marines 566.00 26
11| 10/5/2009 Reserves $68.00 31
12 | 10/6/2009 Army Guard §77.00 33
3| 10/7/2009 Army $93.07 21
14 | 10/8/2009 Navy $105.32 22
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Microsoft EXCEL 2013 - Slicers

Now it’s time to add our slicers. We'll add “Branch” and “Object Class”. See below. You must first click
anywhere within the data. Click the Insert Tab and then the Slicer ICON. Put a check next to the

“Branch” and “Object Class”.

H = ¢== TABLE TOOLS 13
GO HOME | INSERT | PAGELAYOUT  FORMULAS  DATA  REVIEW  VIEW  DEVELOPER DESIGN
. =
; E ea & B oy | s 1% 1 E ]E ]E

PivotTable Recommend Pictures Online Shapes SmartArt Screznshol gy apps - | Recommended i PivotChart Power  Line Column Win/  Slicer T

PivotTables Picture Charts |- - Loss

Tables Hlustrations Apps Charts Reports Sparklines iite
D7 - FAES

A B c D E F G H 1 J K L M N o

1|
2|
3|
4]
5|
PMoate  Elsranch B amoun Tnsert Slicers (2] = |
7 | 10/1/2009 Army
8 | 10/2/2009 Navy [C]pate
9 | 10/3/2009 Air Force [#Branch
10| 10/4/2009 Marines [FJamount «
11| 10/5/2009 Reserves [FObject Class
12 10/6/2009 Army Guard $77.00 33
13| 10/7/2009 Army $93.07 21
14| 10/8/2009 Navy $105.32 22
15| 10/9/2009 Air Force $117.58 25
16 | 10/10/2009 Marines $129.84 26,
17 | 10/11/2009 Reserves $142.10 31
18 10/12/2009 Army Guard 5154.35 33
19 10/13/2009 Army $166.61 21
20 10/14/2009 Navy $178.87 22
21| 10/15/2009 Air Force $191.12 25
22 | 10/16/2009 Marines $203.38 26
23 |10/17/2009 Reserves $215.64 31
24 10/18/2009 Army Guard  $227.90 33
25 | 10/19/2009 Army $240.15 21
26 | 10/20/2009 Navy $252.41 22
27 10/21/2009 Air Force $264.67 25
28 | 10/22/2009 Marines 5276.92 26

See Result below. Your Slicers are displayed. We’ll show you some neat features.

A B c D E 3 G H
1

2

3

a4

5

[MDate Bl eranch B Amount B8 object Class [§ -

7 | 10/1/2009 Army $22.00 21 ObjectClass &
g | 10/2/2009 Navy $24.00 22 21

9 | 10/3/2009 Air Force $44.00 25,
10 | 10/4/2008 Marines $66.00 26 «
11| 10/5/2009 Reserves $68.00 31 25

12 | 10/6/2009 Army Guard 577.00 33 26

13| 10/7/2009 Army $93.07 21

14| 10/8/2009 Navy $105.32 22
15| 10/9/2009 Air Force $117.58 25 33

16 | 10/10/2008 Marines $129.84 26

17 | 10/11/2009 Reserves $142.10 31

18 | 10/12/2009 Army Guard $154.35 33

19 | 10/13/2009 Army 5166.61 21

20 | 10/14/2009 Navy $178.87 22

21| 10/15/2009 Air Force $191.12 25 Branch

22 | 10/16/2009 Marines $203.38 26 Air Force

23 | 10/17/2009 Reserves $215.64 31,
24 |10/18/2009 Army Guard  $227.90 EE

25 | 10/19/2009 Army $240.15 21 Army Guard «
26 | 10/20/2009 Navy $252.41 22 Marines

27 | 10/21/2009 Air Force $264.67 25

28 | 10/22/2009 Marines $276.92 26, ]

29 | 10/23/2009 Reserves $289.18 31 Reserves

30 | 10/24/2009 Army Guard  $301.44 33

31| 10/25/2009 Army $313.70 21

32 | 10/26/2009 Navy $325.95 22

33 | 10/27/2009 Air Force $338.21 25
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WEe’'ll change the Display of the Slicers. First, we’ll change the column from “1’ to “3” for each slicer.
Click on Object Class slicer and choose the Options Tab and change column from “1” to “3”. Do this for
each Slicer. You can resize the box too. See Result below.

E - 2 = SLICER TOOLS

FILE HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW DEVELOPER OPTIONS
Slicer Caption: T i E TT4] [a L B Columns: |3 = [ e

5 d O e . -l [|He
Branch | - 7| Height: [0.2&" =
T —w— g Report Z| Bring Sen Selection Align Group FRotate I - 3wi
S“(E" Seftings | Connections | | - i ! Forward » Backwal -~ Pane X en Widith: 2
Slicer Slicer Styles Arrange Butto

Branch 1 - f\

[ A B & L £ [ £ | ok | sk | B ] M | N | O ¥
1 || ObjectClass Branch ‘
Z r
3| | 21 || 22 “ 75 ‘ | Air Force || Army “ Army Guard |
4 | | 26 || 31 “ 33 ‘ ‘ | Marines || Navy l Reserves | ‘
5

(W pate B eranch B Amount B Object Class B2
7 | 10/1/2009 Army $22.00 21
& | 10/2/2009 Navy $24.00 22
9 | 10/3/2009 Air Force 544,00 25

We need to do one more thing new to Office 2013 Excel. Right click on each Slicer and click “Slicer
Settings”. See Result below.

Object Class 1 | i Je
A B c D E E G
1 i Object Class % | Branch %
2 - Cut
5 | 21 | 22 36 5 / || Army Guard |
| ———— & Copy ,
: it Paste Options: i || e |
5 | -
6 O
? {
8 | 10/2/2009 N i
'M—_EWE%.LI SortAtoZ
9 | 10/3/2009 Air Forc =™

10| 10/4/2009 Marines il sotZiwA
11| 10/5/2009 Reserve T
12 | 10/6/2009 Army Gt =
13| 10/7/2009 Army |
14| 10/8/2009 Mavy

15 | 10/9/2009 AirForc [f1 i

16 | 10/10/2009 Marines 7 Bring to Front b
17 | 10/11/2009 Reserve o
18 | 10/12/2009 Army Gt
19 | 10/13/2009 Army

20| 10/14/2009 Mavy ED Size and Properties...,

21 10/15/2009 Air Forc Slicer Settings...

22 | 10/16/2009 Marines S203.38 26]

Remowe "Object Class"

L Sendto Back »

Assign Macro..,
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Now a put check next to: Hide items with no data. Now it will hide the data, instead of graying out.

Object Class L

f ;

[ A I B | C | D E F G
1 | ObjectClass L | Branch
i ! | 21 ” ZF || 25 | | Air Force “ Army || Army Guard |
4 [ 26 H 31 H 33 ] ‘ I Marines H Mavy H Reserves l
5
G-I.' kdl Bran: b8 Amount kdl Objec 355 [l |
7 jtndad a fannn a1 "
g | Shicer Settings - @lﬂ 1
9

Source Name: Object Class

101 | Mame to use in formulas:  Slicer_Object_Classl

11| | Hame: |Object Class1
12 Header =

13 [¥] Display header

14 Caption: Ob}ect Eiass

15 Item Sorting and Filtering 3
L @ Ascending (Ato ) [¥] Hide items with no data « i
17 () Descending [Z to &) Visually indicate items with no data |
18 [#] Use Custom Lists when sorting [V] show items with no data last L
19

20 [_ oK _] [ Cancel ] )
=L = =

22 110/16/2009 Marines 5203.38 26

23 | 10/17/2009 Reserves 5215.64 31

Now we’ll click “Air Force” within the Slicer named “Branch” and you’ll notice all Object Class

disappeared, except “25”. Now your table below is only displaying what has been chosen using your

Slicer.

Key Notes: Clicking the Filter ICON will turn off all filters. Hold down the CRTL key and use your mouse
to select multiple items. See Result below.
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Object Class 1 - I
A B C D E F G
1 | ObjectClass Branch h 4
4 ‘ Marines Navy Reserves
5
[}l Date hdl Bra B Amo b4 Obje -
9 | 10/3/2009 Air Force $44.00 25
15| 10/9/2009 Air Force $117.58 25
21 | 10/15/2009 Air Farce $191.12 25
27 | 10/21/2009 Air Force $264.67 25
33 | 10/27/2009 Air Force $338.21 25
39 | 11/2/2009 AirForce $411.75 25
45 | 11/8/2009 Air Force 5485.30 25
51 | 11/14/2009 Air Force $558.84 25
57 | 11/20/2009 Air Force $632.38 25
63 | 11/26/2009 Air Force $705.92 25
69 | 12/2/2009 Air Force $779.47 25
75 | 12/8/2009 Air Force $853.01 25

Now we need to move to the Pivot Table and see the new “Timeline” featured added to Office 2013
Excel. Add the “Timeline” feature by clicking “Analyze” tab and then the “Insert Timeline” ICON. See

Result below.

H - c- =

EUS HOME  INSERT  PAGELAVOUT
PivotTable Name: | Active Field:
[PivotTabler | [Date

FORMULAS DATA REVIEW VIEW

= = Group Selection o=
*= Expand Field . 5
88 Ungroup T
Insert  Insert Fifter Refresh €

DEVELOPER

—
PIVOTTABLE

[ options ~ [ Field Settings b:‘m. 3.‘;” = CollapseField 5 Group Field Sihcer Tiindline Gannactions
PivotTable Active Field Group Filter
A7 * Jr || 107172009
A B £ D E F G 1
1
2
3 rop ort Filter Fields Here
4
5 Amount _ _ Insert Timelines (8
6 Date v |Branch |~ ObjectClass - |Total
7 [_=10/1/2008] = Army 2 522.00 [Flpate *
8 | ©10/2/2009 =Navy 22 $24.00|
9 | =10/3/2009 = Air Force 25 $44.00
10 | =10/4/2009 =Marines 25 $66.00
11| =10/5/2009 =Reserves 31 $68.00
12| =10/6/2009 =Army Guai 32 $77.00
13| ©10/7/2009 =Army 21 $93.07]
14| ©10/8/2009 =Navy 22 $105.32
15| ©10/9/2009 = Air Force 25 $117.58
16 | ©10/10/2009 = Marines 2§ $129.84
17 | =10f11/2009 = Reserves 31 $142.10) L -
18| 10/12/2009 = Army Guar 33 $154.35] [T
19 | ©10/13/2009 = Army 21 $166.61
20| ©10/14/2009 = Navy 22 $178.87

ANALYZE

Now put a check next to “Date”. Now you can click the months you want to display. We chose only to

see “Sep”. You can click multiple consecutive months too. See Result below.
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Date

A B
1
2
1
5 | Amount
& Date -1 Branch
7 =19/1/2014 = Air Force
8 -19/2{2014 = Marines
9 -19/3/2014 = Reserves
10 =19/4/2014 = Army Guar
11| =9/5/2014 = Army
12 -19/6/2014 = Navy
13 -19/7/2014 = Air Force
14 -la/8/2014 = Marines
15 -19/9/2014 = Reserves
16 | =9/10/2014 = Army Guai
17| =9/11/2014 = Army

—infaadwna a

25
26
31
33
21
22
25
26
31
33
21

an

~ | Object Class | ~ | Total

$22,033.35
§22,045.61
$22,057.87
422,070.12
§22,082.38
$22,094.64
$22,106.90
$22,119.15
§22,131.41
$22,143.67
422,155.92

[atele Bt F={- I ¥'=]

S

E F G H I
Date A&
Sep 2014 MONTHS
2014
APR  MAY  IUN JUL AUG  SEP

—

You can change your selection by clicking the down arrow. We’ll change it to years. Remember all

selections are based on Calendar year, not Fiscal year. See Result below.

13
14
15
16
17
18
19
20
21
22

Amount
Date T
=-11/1/2014
=11/2{2014
=11/3/2014
=11/4/2014
=1/5/2014
=11/6/2014
=11/7/2014
-11/8/2014
=11f9/2014
-11/10/2014
=-11/11/2014
-11/12/2014
=11/13/2014
-11/14/2014
=11/15/2014
=-11/16/2014

S DUPE

wr

B C D E G H 1
Date .
2014 YEARS *
2011 2012 2013 2014 «
Branch |~ |Object Class| ~ | Total
=l Army Guai 33 519,054.87 | 1 L4
=l Army 21 519,067.12
= Navy 22 $19,079.38
= Air Force 25 519,091.64
-IMarines 26 519,103.90
=|Reserves 3l 519,116.15
=l Army Guai 33 519,128.41
=l Army 21 519,140.67
= Navy 22 §19,152.92
= Air Force 25 519,165.18
=IMarines 26 519,177.44
-|Reserves 31 519,189.70
=l Army Guai 33 519,201.95
= Army 21 819,214.21
= Navy 22 519,226.47
25 §19,238.72

= Air Force

e m—— -
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Now we can add regular Slicers with your Timeline Slicer. See Result below.

o - %

A B C D E F €] H I J K L
1 || Object Class Branch Date )4
2
5 [ 21 H 22 H 25 l [ Air Force H Army H Army Guard l 2012-2014 YEARS
4 [ 26 H 31 H 33 l [ Marines H Navy H Reserves l
5 2011 2012 2013 2014 2015
& | Amount
7 |Date -T/Branch |~ Object Class ~ Total 1 L
8 =11/1/2012 = Army 21 $10,094.90
9 |  =1/2/2012 =Navy 22 $10,107.15
10 =11/3/2012 = Air Force 23 $10,119.41
11 =1f4f2012 = Marines 26 $10,131.67
12 =11f5/2012 = Reserves 31 $10,143.92
13 =11/6/2012 = Army Guai 33 510,156.18
14| =1f7/2012 = Army 21 $10,168.44
15 =1f8f2012 = Navy 22 $10,180.70
16| =1/8/2012 = Air Force 25 $10,192.95
17 | =1/10{2012 = Marines 26 $10,205.21
18| =1/11/2012 - Reserves 31 $10,217.47
19| =1/12/2012 = Army Guai 33 510,229.72
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